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INSTALLATION INSTRUCTIONS

NI SCB-264X

Shielded Connector Block for the NI PXI-2532

CORFaAVBCE BERBR-JDHEFENTVET,

This document describes how to install and connect signals to the
National Instruments SCB-264X shielded connector block. Use the

NI SCB-264X to interface individual signal wires to the rows and columns
of the NI PXI-2532 matrix.

The NI SCB-264X has five ribbon cable connectors for connecting to the
NI TB-2640/2641/2642/2643/2644 (NI TB-264X) connector blocks and
screw terminals for connecting signals. The NI SCB-264X supports all
NI PXI-2532 topologies that are configured with the NI TB-264X. The
NI SCB-264X can be used alone, or it can be rack-mounted using the
included DIN rail-mounting kit.

Note References to the NI TB-264X in this document do not include the NI TB-2645. The
NI TB-2645 is not compatible with the NI SCB-264X.

Refer to the NI Switches Getting Started Guide to determine when to install
the NI SCB-264X. Visit ni .com/switches for information about other
switching solutions.
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Conventions

»

> &

bold

italic

monospace

The following conventions are used in this guide:

The » symbol leads you through nested menu items and dialog box options
to a final action. The sequence File»Page Setup»Options directs you to
pull down the File menu, select the Page Setup item, and select Options
from the last dialog box.

This icon denotes a note, which alerts you to important information.

This icon denotes a caution, which advises you of precautions to take to
avoid injury, data loss, or a system crash. When this symbol is marked on a
product, refer to the Read Me First: Safety and Electromagnetic
Compatibility document for information about precautions to take.

Bold text denotes items that you must select or click in the software, such
as menu items and dialog box options. Bold text also denotes parameter
names.

Italic text denotes variables, emphasis, a cross-reference, or an introduction
to a key concept. Italic text also denotes text that is a placeholder for a word
or value that you must supply.

Text in this font denotes text or characters that you should enter from the
keyboard, sections of code, programming examples, and syntax examples.
This font is also used for the proper names of disk drives, paths, directories,
programs, subprograms, subroutines, device names, functions, operations,
variables, filenames and extensions.

1. Unpack the Shielded Connector Block

Remove the NI SCB-264X from the package and inspect it for loose
components or any sign of damage. Notify NI if the NI SCB-264X appears
damaged in any way.

A Caution Do not install a damaged shielded connector block into your system.
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2. Verify the Components

To install and use the NI SCB-264X you need the following items:

e NI SCB-264X shielded connector block
e NI PXI-2532 switch module

¢ One of the NI TB-264X connector block accessories listed in Table 1

* Installation instructions for the NI TB-264X you are using, accessible

at ni.com/manuals

¢ Ribbon cables (not included)

@ Note Refer to Table 1 for information about ordering ribbon cables for the NI SCB-264X.

* 1/8in. flathead screwdriver
e #1 Phillips screwdriver

*  Long-nose pliers

*  Wire cutter

*  Wire insulation stripper

Table 1. Accessories for the NI SCB-264X

Accessory Part Number

Row and column cable kit for the NI TB-264X terminal blocks 779346-01
NI TB-2640 shielded connector block (4 x 128 1-wire matrix) 779056-01
NI TB-2640 shielded connector block, with protection resistance 779056-02
NI TB-2641 shielded connector block (8 x 64 1-wire matrix) 779056-03
NI TB-2641 shielded connector block, with protection resistance 779056-04
NI TB-2642 shielded connector block (16 x 32 1-wire matrix) 779056-05
NI TB-2642 shielded connector block, with protection resistance 779056-06
NI TB-2643 shielded connector block 779056-07
(4 x 64 2-wire matrix or dual 4 x 64 1-wire matrix)

NI TB-2643 shielded connector block, with protection resistance 779056-08
NI TB-2644 shielded connector block 779056-09
(8 x 32 2-wire matrix or dual 8 x 32 1-wire matrix)

NI TB-2644 shielded connector block, with protection resistance 779056-10

© National Instruments Corporation 3
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3. Install the DIN-Rail Mounting Bracket (Optional)

If you prefer DIN-rail mounting instead of stand-alone operation, the

NI SCB-264X is packaged with an optional DIN-rail mounting bracket.
The bracket can be installed horizontally or vertically to the bottom of the
NI SCB-264X. To install the mounting bracket, align the bracket with the
appropriate horizontal or vertical holes, and secure the bracket to the

NI SCB-264X using the two included screws.

4. Connect the NI SCB-264 X to the NI TB-264X

The NI TB-264X connects to and configures the NI PXI-2532 switch
module into different topologies. To use the NI SCB-264X, you must
connect to the NI PXI-2532 through one of the NI TB-264X terminal
block accessories listed in Table 1. To connect the NI SCB-264X to the
NI TB-264X, refer to Figures 1 and 2 while completing the following steps:

1. Gather the ribbon cables required for connecting the NI SCB-264X to
the NI TB-264X. Depending on which NI TB-264X you are using, you
may have up to four column cables (34-conductor ribbon cables with
2 x 17 connectors) and one row cable (16-conductor ribbon cable with
a 2 x 8 connector). Refer to the installation instructions for your
NI TB-264X for more information about the required cables.

2. Follow the steps in the NI TB-264X installation instructions to connect
the ribbon cables to the NI TB-264X. Note the location of each cable
in the NI TB-264X. Specifically, note whether the cable is connected
to the J2 or J3 connector and whether it is connected to the lower or
upper column connection board.

3. To access the ribbon cable connectors on the NI SCB-264X, insert a
1/8 in. flathead screwdriver into the groove on the edge of the
NI SCB-264X.

4. Carefully turn the screwdriver counterclockwise until the top cover of
the NI SCB-264X unsnaps.

Remove the top cover.

6. Inside the NI SCB-264X there are two strain-relief bars. Loosen the
strain-relief screws on the strain-relief bar closest to the ribbon cable
connectors.

7. Route the ribbon cables through the strain-relief opening.

NI SCB-264X Installation Instructions 4 ni.com



8. Attach the ribbon cables to the column and row ribbon cable
connectors. To secure the cables, ensure that the locking mechanism
engages.

@ Note The installation location of each cable must be consistent with the connections made
inside the NI TB-264X. Use the designators on the NI SCB-264X printed circuit board to
ensure the correct location of each cable. LOWER J2 and LOWER J3 refer to the J2 and J3
connectors on the lower column connection board of the NI TB-264X; UPPER J2 and
UPPER J3 refer to the J2 and J3 connectors on the upper column connection board of the
NI TB-264X. If these connections are incorrect, Tables 2 through 10 are invalid.

9. To connect signal wires to the NI SCB-264X, refer to step 5. Connect
Signals. Otherwise, replace the top cover, and refer to step 6. Connect
the NI TB-264X to the NI PXI-2532.

1 Top Cover 3 Strain-Relief Opening
2 Groove for Screwdriver

Figure 1. NI SCB-264X Shielded Connector Block
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Figure 2. NI SCB-264X Parts Locator Diagram
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9. Connect Signals

To connect signals to the NI SCB-264X, refer to Figures 1 and 2 while
completing the following steps:

1. Prepare the signal wire by stripping the insulation no more than 7 mm
from the end of the wire.

2. Loosen the strain-relief screws on the strain-relief bar closest to the
screw terminals.

3. Route the signal wires through the strain-relief opening.

4. Based on the NI TB-264X you are using, refer to the appropriate table
(Tables 2 through 10) to determine which screw terminal to connect the
signal wire.

5. Insert the stripped end of the wire fully into the terminal. Secure the
wire by tightening the screw of the terminal.

A Caution No bare wire should extend past the screw terminal. Exposed wire increases the
risk of a short-circuit causing a failure.

6. Connect the protective earth (PE) ground to a safety ground lug.
7. Tighten the screws on the strain-relief assemblies to secure the cables.

8. Replace the top cover.

@ Note As illustrated in Figure 2, the NI SCB-264X contains six unused screw terminals,
Node I and Node 2, that you can use to assist in your signal/ground connections.
Node 1 consists of two screw terminals that are connected to each other but are not
connected to any other screw terminals; Node 2 consists of four screw terminals that are
connected to each other but are not connected to any other screw terminals. Node 1 and
Node 2 are not connected together. Use of the node terminals is optional.

Tables 2 through 8 illustrate the wiring configurations available for the
NI SCB-264X.
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Table 2. 1-Wire 4 x 128 Configuration (NI TB-2640)

SCB-264X | Channel SCB-264X | Channel SCB-264X | Channel SCB-264X | Channel SCB-264X | Channel
Name Name Name Name Name Name Name Name Name Name

E.28 C100 D.26 C70 C.09 C40 B.11 C10 B.01 Co
E.27 C101 D.25 C71 C.10 C41 B.12 Cl1 B.02 Cl1
E.26 C102 D.24 C72 C.11 C42 B.13 Cl12 B.03 Cc2
E.25 C103 D.23 C73 C.12 C43 B.14 C13 B.04 C3
E.24 C104 D.22 C74 C.13 C44 B.15 Cl4 B.05 C4
E.23 C105 D.21 C75 C.14 C45 B.16 C15 B.06 C5
E.22 C106 D.20 C76 C.15 C46 B.17 Cl6 B.07 C6
E.21 C107 D.19 C77 C.16 C47 B.18 C17 B.08 Cc7
E.20 C108 D.18 C78 C.17 C48 B.19 C18 B.09 C8
E.19 C109 D.17 C79 C.18 C49 B.20 CI19 B.10 9
E.18 C110 D.16 C80 C.19 C50 B.21 C20 A.01 RO
E.17 Cl11 D.15 C81 C.20 Cs1 B.22 C21 A.02 R1
E.16 Cl12 D.14 C82 C.21 C52 B.23 C22 A.03 R2
E.15 Cl113 D.13 C83 C.22 Cs3 B.24 C23 A.04 R3
E.14 Cl14 D.12 C84 C.23 C54 B.25 C24 A.05 NC
E.13 Cl15 D.11 C85 C.24 C55 B.26 C25 A.06 NC
E.12 Cl16 D.10 C86 C.25 C56 B.27 C26 A.07 NC
E.11 C117 D.09 C87 C.26 C57 B.28 C27 A.08 NC
E.10 C118 D.08 C88 C.27 Cs8 B.29 C28 A.09 NC
E.09 C119 D.07 C89 C.28 C59 B.30 C29 A.10 NC
E.08 C120 D.06 C90 C.29 C60 B.31 C30 A1l NC
E.07 C121 D.05 91 C.30 Co1 B.32 C31 A.12 NC
E.06 Cl122 D.04 C92 C31 C62 C.01 C32 A.13 NC
E.0O5 C123 D.03 C93 C.32 C63 C.02 C33 A.14 NC
E.04 Cl124 D.02 C9%4 D.32 Co4 C.03 C34 A.15 NC
E.03 Cl125 D.01 C95 D31 C65 C.04 C35 A.16 NC
E.02 Cl126 E.32 C96 D.30 C66 C.05 C36 Node 2 NC2
E.01 C127 E31 C97 D.29 co67 C.06 C37 Node 2 NC2
Node 1 NC! E.30 C98 D.28 C68 C.07 C38 Node 2 NC2?
Node 1 NC! E.29 €99 D.27 C69 C.08 C39 Node 2 NC?
NC denotes a channel with no connection.
' The two Node 1 terminals are connected.
2The four Node 2 terminals are connected.
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Table 3. 1-Wire 8 x 64 Configuration (NI TB-2641)

SCB-264X | Channel SCB-264X | Channel SCB-264X | Channel SCB-264X | Channel SCB-264X | Channel
Name Name Name Name Name Name Name Name Name Name
E.28 NC D.26 NC C.09 C40 B.11 C10 B.01 Co
E.27 NC D.25 NC C.10 C41 B.12 Cl1 B.02 Cl1
E.26 NC D.24 NC C.11 C42 B.13 Cl12 B.03 c2
E.25 NC D.23 NC C.12 C43 B.14 C13 B.04 C3
E.24 NC D.22 NC C.13 C44 B.15 Cl4 B.05 C4
E.23 NC D.21 NC C.14 C45 B.16 C15 B.06 C5
E.22 NC D.20 NC C.15 C46 B.17 Cl6 B.07 C6
E.21 NC D.19 NC C.16 C47 B.18 C17 B.08 C7
E.20 NC D.18 NC C.17 C48 B.19 C18 B.09 C8
E.19 NC D.17 NC C.18 C49 B.20 C19 B.10 (%
E.18 NC D.16 NC C.19 C50 B.21 C20 A.01 RO
E.17 NC D.15 NC C.20 C51 B.22 C21 A.02 R1
E.16 NC D.14 NC C.21 C52 B.23 C22 A.03 R2
E.15 NC D.13 NC C.22 C53 B.24 C23 A.04 R3
E.14 NC D.12 NC C.23 C54 B.25 C24 A.05 R4
E.13 NC D.11 NC C.24 C55 B.26 C25 A.06 RS
E.12 NC D.10 NC C.25 C56 B.27 C26 A.07 R6
E.11 NC D.09 NC C.26 C57 B.28 C27 A.08 R7
E.10 NC D.08 NC C.27 C58 B.29 C28 A.09 NC
E.09 NC D.07 NC C.28 C59 B.30 C29 A.10 NC
E.O8 NC D.06 NC C.29 C60 B.31 C30 A.ll NC
E.07 NC D.05 NC C.30 C61 B.32 C31 A.12 NC
E.06 NC D.04 NC C.3l1 C62 C.01 C32 A.13 NC
E.O5 NC D.03 NC C.32 C63 C.02 C33 A.14 NC
E.04 NC D.02 NC D.32 NC C.03 C34 A.l5 NC
E.03 NC D.01 NC D.31 NC C.04 C35 A.16 NC
E.02 NC E.32 NC D.30 NC C.05 C36 Node 2 NC2
E.01 NC E.31 NC D.29 NC C.06 C37 Node 2 NC2
Node 1 NC! E.30 NC D.28 NC C.07 C38 Node 2 NC?
Node 1 NC! E.29 NC D.27 NC C.08 C39 Node 2 NC?
NC denotes a channel with no connection.
' The two Node 1 terminals are connected.
2The four Node 2 terminals are connected.
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Table 4. 1-Wire 16 x 32 Configuration (NI TB-2642)

SCB-264X | Channel SCB-264X | Channel SCB-264X | Channel SCB-264X | Channel SCB-264X | Channel
Name Name Name Name Name Name Name Name Name Name

E.28 NC D.26 NC C.09 NC B.11 C10 B.01 Co
E.27 NC D.25 NC C.10 NC B.12 Cl1 B.02 Cl1
E.26 NC D.24 NC C.11 NC B.13 Cl12 B.03 Cc2
E.25 NC D.23 NC C.12 NC B.14 C13 B.04 C3
E.24 NC D.22 NC C.13 NC B.15 Cl4 B.05 C4
E.23 NC D.21 NC C.14 NC B.16 C15 B.06 C5
E.22 NC D.20 NC C.15 NC B.17 Cl6 B.07 C6
E.21 NC D.19 NC C.16 NC B.18 C17 B.08 Cc7
E.20 NC D.18 NC C.17 NC B.19 C18 B.09 C8
E.19 NC D.17 NC C.18 NC B.20 CI19 B.10 9
E.18 NC D.16 NC C.19 NC B.21 C20 A.01 RO
E.17 NC D.15 NC C.20 NC B.22 C21 A.02 R1
E.16 NC D.14 NC C.21 NC B.23 C22 A.03 R2
E.15 NC D.13 NC C.22 NC B.24 C23 A.04 R3
E.14 NC D.12 NC C.23 NC B.25 C24 A.05 R4
E.13 NC D.11 NC C.24 NC B.26 C25 A.06 RS
E.12 NC D.10 NC C.25 NC B.27 C26 A.07 R6
E.11 NC D.09 NC C.26 NC B.28 C27 A.08 R7
E.10 NC D.08 NC C.27 NC B.29 C28 A.09 R8
E.09 NC D.07 NC C.28 NC B.30 C29 A.10 RO
E.08 NC D.06 NC C.29 NC B.31 C30 A1l R10
E.07 NC D.05 NC C.30 NC B.32 C31 A.12 RI11
E.06 NC D.04 NC C31 NC C.01 NC A.13 R12
E.0O5 NC D.03 NC C.32 NC C.02 NC A.14 R13
E.04 NC D.02 NC D.32 NC C.03 NC A.15 R14
E.03 NC D.01 NC D31 NC C.04 NC A.16 R15
E.02 NC E.32 NC D.30 NC C.05 NC Node 2 NC2
E.01 NC E31 NC D.29 NC C.06 NC Node 2 NC2
Node 1 NC! E.30 NC D.28 NC C.07 NC Node 2 NC2?
Node 1 NC! E.29 NC D.27 NC C.08 NC Node 2 NC?
NC denotes a channel with no connection.
' The two Node 1 terminals are connected.
2The four Node 2 terminals are connected.
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Table 5. 2-Wire 4 x 64 Configuration (NI TB-2643)

SCB-264X | Channel SCB-264X | Channel SCB-264X | Channel SCB-264X | Channel SCB-264X | Channel
Name Name Name Name Name Name Name Name Name Name
E.28 C50+ D.26 C35+ C.09 C20+ B.11 C5+ B.01 COo+
E.27 C50- D.25 C35- C.10 C20- B.12 C5- B.02 COo-
E.26 C51+ D.24 C36+ C.11 C21+ B.13 Co+ B.03 Cl+
E.25 C51- D.23 C36- C.12 C21- B.14 C6- B.04 Cl-
E.24 C52+ D.22 C37+ C.13 C22+ B.15 C7+ B.05 C2+
E.23 C52- D.21 C37- C.14 C22- B.16 C7- B.06 C2-
E.22 C53+ D.20 C38+ C.15 C23+ B.17 C8+ B.07 C3+
E.21 C53— D.19 C38- C.16 C23- B.18 C8- B.08 C3-
E.20 C54+ D.18 C39+ C.17 C24+ B.19 Co9+ B.09 C4+
E.19 C54- D.17 C39- C.18 C24- B.20 C9- B.10 C4-
E.18 C55+ D.16 C40+ C.19 C25+ B.21 C10+ A.01 RO+
E.17 C55- D.15 C40- C.20 C25- B.22 C10- A.02 RO-
E.16 C56+ D.14 Ca1+ C.21 C26+ B.23 Cll+ A.03 R1+
E.15 C56— D.13 C41- C.22 C26— B.24 Cll- A.04 R1-
E.14 C57+ D.12 C42+ C.23 C27+ B.25 Cl2+ A.05 R2+
E.13 C57- D.11 C42- C.24 C27- B.26 Cl12- A.06 R2-
E.12 C58+ D.10 C43+ C.25 C28+ B.27 Cl13+ A.07 R3+
E.11 C58- D.09 C43- C.26 C28- B.28 C13- A.08 R3-
E.10 C59+ D.08 C44+ C.27 C29+ B.29 Cl4+ A.09 NC
E.09 C59—- D.07 C44- C.28 C29- B.30 Cl4- A.10 NC
E.O8 C60+ D.06 C45+ C.29 C30+ B.31 Cl15+ A.ll NC
E.07 C60- D.05 C45- C.30 C30- B.32 Cl15- A.12 NC
E.06 Co61+ D.04 C46+ C.3l1 C31+ C.01 Cl6+ A.13 NC
E.O5 C61- D.03 C46- C.32 C31- C.02 Clo— A.14 NC
E.04 Co2+ D.02 C47+ D.32 C32+ C.03 C17+ A.l5 NC
E.03 C62- D.01 C47- D.31 C32- C.04 C17- A.16 NC
E.02 C63+ E.32 C48+ D.30 C33+ C.05 C18+ Node 2 NC2
E.01 C63— E.31 C48- D.29 C33- C.06 C18- Node 2 NC2
Node 1 NC! E.30 C49+ D.28 C34+ C.07 C19+ Node 2 NC?
Node 1 NC! E.29 C49- D.27 C34- C.08 C19- Node 2 NC?
NC denotes a channel with no connection.
' The two Node 1 terminals are connected.
2The four Node 2 terminals are connected.
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Table 6. Dual 4 x 64 Configuration (NI TB-2643)

SCB-264X | Channel SCB-264X | Channel SCB-264X | Channel SCB-264X | Channel SCB-264X | Channel
Name Name Name Name Name Name Name Name Name Name

E.28 BOC50 D.26 BOC35 C.09 B0C20 B.11 BOC5 B.01 BOCO
E.27 B1C50 D.25 B1C35 C.10 B1C20 B.12 BI1C5 B.02 B1CO
E.26 BOCS51 D.24 BOC36 C.11 B0C21 B.13 BOC6 B.03 BOC1
E.25 BI1C51 D.23 B1C36 C.12 BlC21 B.14 BIC6 B.04 BICI
E.24 B0C52 D.22 BOC37 C.13 B0C22 B.15 B0OC7 B.05 BOC2
E.23 B1C52 D.21 B1C37 C.14 B1C22 B.16 BIC7 B.06 BIC2
E.22 BOC53 D.20 BOC38 C.15 B0C23 B.17 BOCS8 B.07 BOC3
E.21 B1C53 D.19 B1C38 C.16 B1C23 B.18 BI1C8 B.08 B1C3
E.20 B0OC54 D.18 BOC39 C.17 B0C24 B.19 BOC9 B.09 BOC4
E.19 B1C54 D.17 B1C39 C.18 B1C24 B.20 BIC9 B.10 B1C4
E.18 BOCS5 D.16 B0C40 C.19 B0C25 B.21 BOCI10 A.01 BORO
E.17 B1C55 D.15 B1C40 C.20 B1C25 B.22 BICIO A.02 BIRO
E.16 BOC56 D.14 B0C41 C.21 B0C26 B.23 BOCI11 A.03 BOR1
E.15 B1C56 D.13 B1C41 C.22 B1C26 B.24 BICl11 A.04 BI1RI
E.14 BOC57 D.12 B0C42 C.23 BOC27 B.25 BOCI12 A.05 BOR2
E.13 B1C57 D.11 B1C42 C.24 B1C27 B.26 BICI2 A.06 BIR2
E.12 BOC58 D.10 B0C43 C.25 B0C28 B.27 BOCI13 A.07 BOR3
E.11 B1C58 D.09 B1C43 C.26 B1C28 B.28 BICI3 A.08 BIR3
E.10 BOC59 D.08 B0C44 C.27 B0C29 B.29 BOC14 A.09 NC
E.09 B1C59 D.07 B1C44 C.28 B1C29 B.30 B1Cl14 A.10 NC
E.08 BOC60 D.06 BOC45 C.29 BOC30 B.31 BOCI15 A1l NC
E.07 B1C60 D.05 B1C45 C.30 B1C30 B.32 BICIS A.12 NC
E.06 BOC61 D.04 B0C46 C31 BOC31 C.01 BOCI16 A.13 NC
E.0O5 B1C61 D.03 B1C46 C.32 B1C31 C.02 BICI6 A.14 NC
E.04 B0C62 D.02 BOC47 D.32 B0C32 C.03 BOC17 A.15 NC
E.03 B1C62 D.01 B1C47 D.31 B1C32 C.04 BI1C17 A.16 NC
E.02 B0OC63 E.32 B0C48 D.30 B0C33 C.05 BOCI18 Node 2 NC2
E.01 B1C63 E31 B1C48 D.29 B1C33 C.06 BICI8 Node 2 NC2
Node 1 NC! E.30 B0C49 D.28 B0C34 C.07 BOCI9 Node 2 NC2?
Node 1 NC! E.29 B1C49 D.27 B1C34 C.08 BIC19 Node 2 NC?
NC denotes a channel with no connection.
' The two Node 1 terminals are connected.
2The four Node 2 terminals are connected.
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Table 7. 2-Wire 8 x 32 Configuration (NI TB-2644)

SCB-264X | Channel SCB-264X | Channel SCB-264X | Channel SCB-264X | Channel SCB-264X | Channel
Name Name Name Name Name Name Name Name Name Name

E.28 NC D.26 NC C.09 C20+ B.11 C5+ B.01 COo+
E.27 NC D.25 NC C.10 C20- B.12 C5- B.02 COo-
E.26 NC D.24 NC C.11 C21+ B.13 Co+ B.03 Cl+
E.25 NC D.23 NC C.12 C21- B.14 C6- B.04 Cl-
E.24 NC D.22 NC C.13 C22+ B.15 C7+ B.05 C2+
E.23 NC D.21 NC C.14 C22- B.16 C7- B.06 C2-
E.22 NC D.20 NC C.15 C23+ B.17 C8+ B.07 C3+
E.21 NC D.19 NC C.16 C23- B.18 C8- B.08 C3-
E.20 NC D.18 NC C.17 C24+ B.19 Co9+ B.09 C4+
E.19 NC D.17 NC C.18 C24- B.20 C9- B.10 C4-
E.18 NC D.16 NC C.19 C25+ B.21 C10+ A.01 RO+
E.17 NC D.15 NC C.20 C25- B.22 C10- A.02 RO-
E.16 NC D.14 NC C.21 C26+ B.23 Cll+ A.03 R1+
E.15 NC D.13 NC C.22 C26— B.24 Cll- A.04 R1-
E.14 NC D.12 NC C.23 C27+ B.25 Cl2+ A.05 R2+
E.13 NC D.11 NC C.24 C27- B.26 Cl12- A.06 R2-
E.12 NC D.10 NC C.25 C28+ B.27 Cl13+ A.07 R3+
E.11 NC D.09 NC C.26 C28- B.28 C13- A.08 R3-
E.10 NC D.08 NC C.27 C29+ B.29 Cl4+ A.09 R4+
E.09 NC D.07 NC C.28 C29- B.30 Cl4- A.10 R4-
E.O8 NC D.06 NC C.29 C30+ B.31 Cl15+ A.ll R5+
E.07 NC D.05 NC C.30 C30- B.32 Cl15- A.12 R5-
E.06 NC D.04 NC C.3l1 C31+ C.01 Cl6+ A.13 R6+
E.O5 NC D.03 NC C.32 C31- C.02 Clo— A.14 R6-
E.04 NC D.02 NC D.32 NC C.03 C17+ A.l5 R7+
E.03 NC D.01 NC D.31 NC C.04 C17- A.16 R7-
E.02 NC E.32 NC D.30 NC C.05 C18+ Node 2 NC2
E.01 NC E.31 NC D.29 NC C.06 C18- Node 2 NC2
Node 1 NC! E.30 NC D.28 NC C.07 C19+ Node 2 NC?
Node 1 NC! E.29 NC D.27 NC C.08 C19- Node 2 NC?
NC denotes a channel with no connection.

' The two Node 1 terminals are connected.

2The four Node 2 terminals are connected.
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Table 8. Dual 8 x 32 Configuration (NI TB-2644)

SCB-264X | Channel SCB-264X | Channel SCB-264X | Channel SCB-264X | Channel SCB-264X | Channel
Name Name Name Name Name Name Name Name Name Name

E.28 NC D.26 NC C.09 B0C20 B.11 BOC5 B.01 BOCO
E.27 NC D.25 NC C.10 B1C20 B.12 BI1C5 B.02 B1CO
E.26 NC D.24 NC C.11 B0C21 B.13 BOC6 B.03 BOC1
E.25 NC D.23 NC C.12 BlC21 B.14 BIC6 B.04 BICI
E.24 NC D.22 NC C.13 B0C22 B.15 BOC7 B.05 B0OC2
E.23 NC D.21 NC C.14 B1C22 B.16 BIC7 B.06 BIC2
E.22 NC D.20 NC C.15 B0C23 B.17 BOCS8 B.07 BOC3
E.21 NC D.19 NC C.16 B1C23 B.18 BI1C8 B.08 B1C3
E.20 NC D.18 NC C.17 B0C24 B.19 BOC9 B.09 BOC4
E.19 NC D.17 NC C.18 B1C24 B.20 BIC9 B.10 B1C4
E.18 NC D.16 NC C.19 B0OC25 B.21 BOC10 A.01 BORO
E.17 NC D.15 NC C.20 B1C25 B.22 BICIO A.02 BIRO
E.16 NC D.14 NC C.21 B0C26 B.23 BOCI11 A.03 BOR1
E.15 NC D.13 NC C.22 B1C26 B.24 BICl11 A.04 BI1RI
E.14 NC D.12 NC C.23 BOC27 B.25 BOCI12 A.05 BOR2
E.13 NC D.11 NC C.24 B1C27 B.26 BICI2 A.06 BIR2
E.12 NC D.10 NC C.25 B0C28 B.27 BOCI13 A.07 BOR3
E.11 NC D.09 NC C.26 B1C28 B.28 BICI3 A.08 BIR3
E.10 NC D.08 NC C.27 B0C29 B.29 BOC14 A.09 BOR4
E.09 NC D.07 NC C.28 B1C29 B.30 B1Cl14 A.10 BI1R4
E.08 NC D.06 NC C.29 BOC30 B.31 BOCI15 A1l BORS
E.07 NC D.05 NC C.30 B1C30 B.32 BICIS A.12 BIRS
E.06 NC D.04 NC C31 BOC31 C.01 BOCI16 A.13 BOR6
E.0O5 NC D.03 NC C.32 B1C31 C.02 BICI6 A.14 BIR6
E.04 NC D.02 NC D.32 NC C.03 BOC17 A.15 BOR7
E.03 NC D.01 NC D.31 NC C.04 BI1C17 A.16 BIR7
E.02 NC E.32 NC D.30 NC C.05 BOCI18 Node 2 NC2
E.01 NC E31 NC D.29 NC C.06 BICI8 Node 2 NC2
Node 1 NC! E.30 NC D.28 NC C.07 BOCI9 Node 2 NC2?
Node 1 NC! E.29 NC D.27 NC C.08 BIC19 Node 2 NC?
NC denotes a channel with no connection.
' The two Node 1 terminals are connected.
2The four Node 2 terminals are connected.
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6. Connect the NI TB-264 X to the NI PXI-2532

To connect the NI TB-264X to the NI PXI-2532, refer to the appropriate
installation instructions for your NI TB-264X.

Figure 3 illustrates the NI SCB-264X connected to the NI PXI-2532
through the NI TB-2640.

@ Note The number of ribbon cables required and the cable connections will differ for each
NI TB-264X.

1 NI SCB-264X 2 Ribbon Cables 3 NI TB-2640 4 NI PXI-2532

Figure 3. NI SCB-264X Connections Using the NI TB-2640
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Specifications

This section lists additional specifications for the NI SCB-264X used with
the NI PXI-2532. All specifications are subject to change without notice.
Visit ni.com/manuals for the most current specifications.

Input Characteristics

All input characteristics are DC, AC, ora combination unless otherwise
specified.

Maximum switching voltage

Channel-to-channel.......................... 60V
Channel-to-ground...........cccceceerueenee. 60V, CATI

Maximum current (per channel)............. 05A

DC path resistance .........cccceeeeeverueeceennenne <2.0 Q + cable resistance

National Instruments, NI, ni.com, and LabVIEW are trademarks of National Instruments Corporation. Refer to the Terms of Use section on
ni.com/legal for more information about National Instruments trademarks. Other product and company names mentioned herein are
trademarks or trade names of their respective companies. For patents covering National Instruments products/technology, refer to the appropriate
location: Help»Patents in your software, the patents . txt file on your media, or the National Instruments Patent Noticeatni . com/patents.
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